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GUIDELINES FOR FLAME UNIVERSITY’S ONLINE UNDERGRADUATE ADMISSION PROCESS

Dear applicants,

Greetings from FLAME University.

FLAME University’s admission process is conducted completely online. You will be able to attend the
admission process from your home.

As a part of your online admission process, you are required to complete an entrance test (FLAME Entrance
Aptitude Test, if you do not have SAT or ACT scores), Essay and One-way Video Interview. FEAT (if
applicable), Essay and One-way Video Interview are conducted online on the same day.

a)

b)

c)

FLAME Entrance Aptitude Test (FEAT) is an online examination (multiple choice questions)
divided into 4 sections - Verbal Ability, Reasoning Ability, Quantitative Ability and General
Knowledge. Total duration of the FEAT shall be 120 minutes. For applicants who have
submitted their SAT/ACT scores, only Essay and One-way Video Interview will be conducted
(FEAT is optional for them).

Essay: During the online admission process, you will be required to complete an essay, the topic of
which will be provided on the spot. You are required to complete your essay in ~200-250 words

after you complete the FEAT (if applicable). You will be given 20 minutes for the on-the-spot
essay.

One-way Video Interview: This part of the admission process will also be conducted online right
after you complete the FLAME Entrance Aptitude Test (FEAT) and the Essay. During the One-way
Video Interview, you will be required to record your responses to three questions. For each
question you will be given 30 seconds to gather your thoughts. You will have to express your
thoughts for each question in not more than 90 seconds. Thus, the total time for the One-way
Video Interview will be 6 minutes. The video interview questions will appear one at a time on
your screen and you will be asked to record an answer for each.

Below you will find a comprehensive step by step guide of the online admission process. This has been
designed to ease your navigation through the online assessment on the day of your admission process. We
highly recommend you to review the guide before your scheduled FLAME University admission process
day. For any questions, please write to us at admission@flame.edu.in.

We wish you the very best.

Sincerely,

FLAME University Admissions Committee

Note: You are required to carry your AADHAR card or PAN card or Passport. This will serve as an identity
proof for you to attend FLAME University’s online admission process. Only originals shall be treated as valid
proof of identity. You are required to keep the same handy during the entire online admission process. Please
ensure that you start the online admission process at your scheduled time.
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STEPS BEFORE YOU BEGIN YOUR ONLINE ADMISSION PROCESS - CHECK SYSTEM COMPATIBILITY

A few days prior to your scheduled admission process day, you will receive an email with links to check your system
compatibility and to start your admission process. We recommend to check your system compatibility before your
scheduled admission process day. In the event that you are not able to do so, you can check the system compatibility on
your scheduled admission process day as well. It does not take more than a few minutes. Kindly note, that the time taken
to check your system compatibility, is not counted towards the duration of your admission process.

1) Launch the Systems Test Window — Click on ‘Launch Test’ to initiate checking your system

compatibility.

=]

Rg FTAME
UNIVERSITY

Online Admi

Launch Test

Facing technical difficulties taking this test? ¢, +91 82878 03040 d

2) Download browser extension.

Chrome version 63 and above, Internet Explorer version 10 and above, Firefox version 52 and above and Safari version
12 and above will support FLAME University’s online admission process. We recommend using Chrome as your browser.

2 FLAME

UNIVERSITY

Online Admission Process 2021

Permission to download a useful browser extension

Step 1 Pgase [elledy(=:I=0 & folow these steps below to continue

Step 2 Click on the "Add Extension” button in the popup Step 3 The extension would get added/downloaded successfully

| 3 w |

Add "Mett] - Sharing Candidate Screen? ‘i/l Mettl - Sharing Candidate Screen has x
-

been added to Chrome.

Manage your extonsions by clicking Extonsions in
the Window menu.

wesn 1
[T PR ———
+ Capnonconens o your sren

Facing technical difficulties taking this test? ¢, +91 82878 03040 =
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3) Ifdownloading browser extension fails, follow the following steps:

a) Copy the highlighted link, open a new browser window, paste it in the URL bar and press enter.

Extension installation failed

Follow these steps below to continue

Step 1 Copy the link below, open in a new window, paste it in the URL bar and click enter to access this url.

Step 2 Click on Add to chrome button on extension page you opened in other window Step 3 After installing exlension please retumn to this page and restart this page fo
continue

' @
J Refresh this page

after instaling extension

Incase you are not able to install extension after following
@ Compatitie mich your device these steps, than please contact your test admnistrator

Facing technical difficulfies taking this test? ¢, +91 82878 03040 =2

b) Click on ‘Add to Chrome’ or the web browser that you may are using.

&~ chrome web store

Home > Extensions > MettlTests: Enable Screen Sharing

]
Mettl Tests : Enable Screen Sharing

Offered by: mettl.com

1

% J ok K 306 | Accessibility | & 500,000+ users

Overview Reviews Support Related

Proctoring is how more
secure with Screen Sharing

Mettl Tests : Enable Screen Sharing

Page 3 of 23



UNIVERSITY

= FLAME

c) Click on ‘Add Extension’ and wait till the extension is installed. Please note, once the installation is complete, you

need to refresh the test window. Once it is refreshed, you are ready to start the test.

& chrome web store

Home > Extensions > Mettl Tests: Enal

Mettl Tests: Ena

Offered by: mettl.com

&1

7 % J ¥ & 306 | Accessib

-‘ﬁ Add "Mettl Tests : Enable Screen Sharing™?

It can:

Read and change your data on a number of websites
Show Details

Read your browsing histary

Capture content of your screen

Overview Reviews Support Related

Proctoring is now more
secure with Screen Sharing

Mettl Tests : Enable Screen Sharing

e remlFOBRTCII O EEARNEBOARAC

Checking..

£~ chrome web store

Home > Extensions > MettlTests : Enable Screen Sharing

‘/I Mettl Tests : Enable Screen Sharing
o

Offered by: mettl.com

% J ¥ # 306 | Accessibility | & 500,000+ users

QOverview Reviews Support Related

Proctoring is now more

secure with Screen Sharing

Mettl Tests : Enable Screen Sharing

@ hkjemkcbndldepdb...crx
Adding to Chrome. .

Checking...

Show all

x|
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4) Enable screen sharing - Select the screen and click on ‘Share’. Applicants have to share their screen
with the proctor before they commence the online admission process.

4
FLA Share your entire screen
UNIVERSITY

_ Mett| Tests : Enable Screen Sharing wants to share the contents of your screen with tests.mettl.com. Choose
Online Admission Process 2021

what you'd ke to share.

Facing technical difficulties taking this test? &, +91 82878 03040 =5

5) Give webcam and audio permissions.

a) Ifthe screen below does not appear, kindly wait for a few seconds for the next screen. Sometimes, it takes a few
seconds for the webcam to switch on.

tests.mettl.com wants to
{}

& Use your microphens

W Use your camera

Allow Block

Give webcam and audio permissions

Allow test.mettl.com to access your microphone and camera In case you dont see the first option click on the right side of address bar to allow
« C £ https// tests.mettl.com/authenticateKey/dBebact6 * 5
# Apps (@ x fultfor | his page has been blocked from accessing your camera and microphone. |

https:// metil.com wants to: ® Ahways allow https://mettl.com to access your camera and microphane|

Continue blocking camera and microphene access

Allow Block Microphone:

Camera:

™ Use your camera

Done

This is a proctored assessment which will require access to your webcam and audio. At this step, we will check the functioning of your webcam and microphone and will not store any
images/videos or voices

Facing| || tests.mettlcom is sharing your screen. [ESTTRUTICEN ide =
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b) In case you don'’t see the first option above, click on the right side of address bar to allow access to your camera and
microphone.

B2 FLAME

UNIVERSITY

Online Admission Process 2021

Give webcam and audio permissions

Allow test. mettl.com to access your microphone and camera In case you dont see the first option click on the right side of address bar to allow

€« C [ hitps:// tests.mettl.com/authenticateKey/d8ebac66 R .
i Apps (@ x ultfor | This page has been blocked from accessing your camera and microphone. |

Etps,/ meti.com Wants io: ®  Atways allow hitps://mett.com 1o access your camera and microphone
Continue blocking camera and microphone access

“Allow | | Block Microphone:

Camera:

™ Use your camera

Facing technical difficulties taking this test? ¢, +91 82878 03040 =

6) Hide the share screen widget shown below. Before clicking on ‘Proceed’, read the instructions on this
screen carefully.

]
FLA
@

UNIVERSITY

Online Admission Process 2021

'Hide' share screen widget as shown below

For the best test taking experience, hide the widget below and click on proceed
(Clicking on 'Stop sharing' will close your test)
Alternatively your test will start in 30 seconds

Please click on ‘Hide’ button in the share screen widget as shown below,
Share screen widget is located at the most bottom of this screen

Page 6 of 23



:JI FLAME

UNIVERSITY

7) Setup your surrounding and ‘Proceed to recording’.

B2 FLAME

UNIVERSITY

Online Admission Process 2021

Set up your surrounding

Please ensure these conditions before you start recording your video.

VI

You are in a noise free You are in a well Iit space Your microphone is un-muted & You are appropriately dressed
environment working

Facing technical difficulties taking this test? ¢, +91 82878 03040 =

8) Testrecording your video and audio. Please ensure your face is clearly visible in the given space and
click on ‘Start Recording’. Test record the text displayed.

>

FLA

UNIVERSITY

Online Admission Process 2021

SRR e

tep 1 of 2 - Record your video

Record yourself saying -

"Surround yourself with positive people and you will
have a positive outcome"

.

Hide

tests.mettl.com is sharing your screen. ISR IENRNY
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9) On completion, click on ‘Stop recording’

]
FLA
»

UNIVERSITY

Online Admission Process 2021

Step 1 of 2 - Record your video

Record yourself saying -

"Surround yourself with positive people and you will
have a positive outcome.”

W Stop Recording ,

~

“\‘\.‘
tests.mettl.com is sharing your screen. [EESTREIERNTR i

10) Check your recording quality by clicking on ‘View Response’.

T TLAME

Online Admission Process 2021

Step 1 of 2 - Record your video

U Record yourself saying -
)

"Surround yourself with positive people and you will
have a positive outcome.”

‘Your video has been recorded.
Click on "View Response' fo view recording

—u E — ——

Facing| || testsmetticom i sharing your screen. [NECCEICIAVIN Hide [
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11) If you can see and hear your recording clearly, click on ‘Yes’ and ‘Proceed’.

B2 FLAME

UNIVERSITY

Online Admission Process 2021

Step 2 of 2 - View your recording

@ Can you see & hear yourself clearly?

@ Great! Click on the proceed button to give your test.
Please maintain the similar device settings and surrounding
conditions around you throughout the duration of the test.

0aroe

Facin tests.mettl.com is sharing your screen. Stop sharing Hide =

12) If you cannot see or hear your recording clearly, click on ‘No’ and ‘Record Video Again’.

:; FLAME
UNIVERSITY

Online Admission Process 2021

Step 2 of 2 - View your recording

@ Can you see & hear yourself clearly?

Yes

O Try the following & Record your video again

- Ensure that your microphone and webcam are properly connecled
- Make sure your microphone is not muted & speaker volume is up.
- Please move Io a noise less & welllit surrounding

- Position yourself at fhe cenire of the video frame.

O Please make sure thal your video has clear scund and image,
athervise your f=sh

@ Record video again

£a |1 testsmettcom is sharing your screen. [EESURULUIN Hide
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13) Once you are satisfied with the quality of your recording, click on ‘Proceed’ and wait for the different

components/sections of FLAME University’s admission process to load.

»2 FLAME

UNIVERSITY

Online Admission Process 2021

Your test is loading...

To ensure an uninterrupted fest-taking experience,
you may close all chat windows,
screen-saver(s) etc before starting the test.
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STEPS TO BEGIN YOUR ONLINE ADMISSION PROCESS

14) Once the different components/sections of the admission process are loaded, click on ‘Next’ to
commence.

ng TLAME

Online Admission Process 2021

Your test has loaded. Click "Next" to continue

Please close all programs that upload
or download files in the background °
For example: Dropbox, torrent, etc.

Next

e S

Facing technical difficulties taking this test? ¢, +91 82878 03040 =

15) Read the FLAME University online admission process instructions very carefully, before you click on
‘Proceed’. It is very important that you do not refresh your browser window (do not press F5), do not
navigate or click away from the shared window and disable all automatic updates in your system.

TESTDETALS

= Hids Sectionwise Detlls

mettl.com/test-window/2elzinsdcg#collapseOne
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16) Just few more steps remain to begin the FLAME University online admission process.

a) Complete your registration details, accept the terms & conditions and click on ‘Next’.

B2 FLAME

UNIVERSITY

Just few more sieps to begin your test.__

* indicates required field

Step1: Fill Registration Details Step2: Provide your snapshot Step3: Take snapshot of ID card

Email Address * registeredemail@domain.com
First Name * XYZ

Application ID * UGLEXXOO0MK

Terms and Conditions * :

By using our offerings and services, you are agreeing to the Terms of services and License Agreement and understand that your use and access will be subject to the terms
and conditions and Privacy Nofice contained therein

Facing technical difficulties taking this test? ¢, +91 82678 03040 == Privacy Notice

b) Provide a clear snapshot of yourself. Kindly adjust your face on the given screen. If your face does not appear clearly
or the image is blurred, click on “Recapture your face’. Once a clear snapshot is provided, click on ‘Next.

B2 FLAME

UNIVERSITY

Just few more steps to begin your test...

—

Step2: Provide your snapshot Step3: Take snapshot of ID card

Captured Face Previev

Blurred Image

Uneven Light on face Looking away from
camera

Recapture your face Next
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c) Take a clear snapshot of your valid identity card (AADHAR card or PAN card or Passport).

B2 FLAME

UNIVERSITY
Just few more steps to begin your test...

—

Step1: Fill Registration Details Step2: Provide your snapshot

Recapture your ID in case of the following issues

W

u Light on Card
Card is Rolated neven Lignton Lar

Facin || testsmettlcom is sharing your screen. [EECTSERNLERN Hide |

17) Click on ‘Start Test’ and then on ‘Proceed to Test’ to begin the FLAME University online admission
rocess. Your entire admission process will be monitored.

D% LA

Facing technical difficulties taking this test? €, +91 82878 03040 =
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Monitored Session

Mettl will monitor your session for review.

Please note that by proceeding to participate and/or
complete this session you consent to be monitored via
video/screen feed. This monitoring is being undertaken to
eliminate any use of unfair means during conduct of this
session. The said video/screen feed can be viewed
whether on a real time basis and/or accessed subsequently
by an authorised personnel only.

Proceed to Test

Page 14 of 23
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STEPS DURING YOUR ONLINE ADMISSION PROCESS

Section 1 : FLAME Entrance Aptitude Test (FEAT)

18) Please read the instructions for the FEAT carefully before clicking on ‘OK’.

ﬂ Section Instructions for FLAME Entrance Aptitude Test, FEAT

FEAT is an online examination (MCQ based) divided into 4 sections given below:
Verbal Ability - 40 Questions (50 marks)

Reasoning (Analytical and Logical) - 20 questions (40 marks)

Quantitative ability - 20 questions (30 marks)

General knowledge - 20 questions (20 marks)

Total duration of the FEAT shall be 120 minutes

Once you complete the FEAT, you will be able to move on to the Essay section

You can resolve questions in any sequence in this section. Please ensure that you have attempted all questions before you finish
the test to proceed to the next section.

Please use time judiciously!

19) During the FEAT, you can attempt any question in any order. However, you must complete this
component/section of the admission process within the stipulated duration.

> Tolal 02:22:12
ELAM E Online Admission Process 20216) > - Finish Test
’ UNIVERSITY Section 01:56:12

Section 103 @ < 900f100 | = All “ 3%
Question # 93 (# Revisit Choose the best option

Identify the error in the given sentence. O Chose
D For
Lisa chose to go to Lendon for higher studies, as she found life in London to be vibrant and exciting -
O Vibrant
@® No Error

Support & +9182878 03040 = Prev Questin
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20) Once you complete the FEAT component/section of the admission process, please click on ‘Next

Section’ to proceed to the online Essay. The ‘Next Section’ button can be found in the window that
displays the final FEAT question.

> Total 021828
FLAM E Online Admission Process 2021 &) Finish Test
’ UNIVERSITY Section 01:52:28

Section 1073 & = | 1000f100 | = All “ 36
Question # 100 ({r Revisit Choose the best option

Arrange the following sentences in a logical order to construct a coherent paragraph (O BCDA
A However, hydrogen is much less abundant on the Earth OABCD
B. In the universe, hydrogen is apparently the most abundant of all the elements O ADBC
C. For instance, analysis of the light emitted by stars indicates that most stars are predominantly
hydrogen. Molecular hydrogen is the lightest of all gases

D. Similarly, of the Sun's mass, approximately 90% is hydrogen Clear Respons

®BCAD

Support & +91 82878 03040 i Prev Questifh ‘

21) Before you click “Finish Section”, kindly ensure that you have attempted all possible questions in the

FEAT. Once you proceed to the online Essay, you will not be able to come back and attempt any
questions from the FEAT component/section of the admission process.

A Finish Section

Are you sure you want to finish this section and start the other section?

You will not be able to attempt this section again

Cancel Yes, Finish section

Page 16 of 23
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Section 2 : Essay

22) Please read the instructions for the online Essay carefully before clicking on ‘OK’.

v Section Instructions for Essay

You are given 20 minutes to write an essay on the given topic.
Once you complete the Essay, you will be able to move on to the One-way Video Interview section

Please use time judiciously!

23) An essay topic will be given on the spot. You are required to complete your essay in ~200-250 words.

You must complete the Essay component/section of the admission process within the stipulated

duration. Once you complete the Essay, please click on ‘Next Section’ to proceed to the One-way Video

Interview.

= Total 00:25.06
FLAME Online Admission Process 2021 €) D == Finish Test
' UNIVERSITY Section 00:19:06

Question # 1 (# Revisit <<{ Enter your response
pE—

Express your views [ not more than 250 words o 'ihe given topic B I U x x Q
u 3

= .
= u

Are reality shows damaging our perception of the world? Hello Good afternoon

Total words - 3

Support & +9182878 03040 = \
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24) Before you click “Finish Section”, kindly ensure that you have checked your response to the Essay
question. Once you proceed to the One-way Video Interview, you will not be able to come back to
review or edit the Essay component/section of the admission process.

A Finish Section

Are you sure you want to finish this section and start the other section?

“YYou will not be able to attempt this section again

Cancel Yes, Finish section

Section 3 : One-way Video Interview

25) Please read the instructions for the One-way Video Interview carefully before clicking on ‘OK’.

@ Section Instructions for One-way Video Interview

In this section, you will be required to record your responses to three guestions.

For each question you will be given 30 seconds to gather your thoughts. You will have to express your thoughts for each question
in not more than 90 seconds. Thus, the total time for the One-way Video Interview will be 6 minutes.

Itis an opportunity to express what may not be stated in your application.

Recording is allowed only once!

Page 18 of 23
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26) During the One-way Video Interview, you will be required to record your responses to three
uestions. For each question you will be given 30 seconds to gather your thoughts. After 30 seconds
recording will start automatically. You will have to express your thoughts for each question in not
more than 90 seconds (cumulative 2 minutes per question). Thus, the total time for the One-way
Video Interview component/section of the online admission process will be 6 minutes. The video
i ear one at a time on your screen and you will be asked to record an

interview questions will a
answer for each. If you finish early, you can click on ‘Stop recording’. You will not be able to edit your

responses, once the recording is completed.

> Total 00:05:43
| FLAME Online Admission Process 20216 1 Finish Test
4' UNIVERSITY Section 00:05:43
Section30i 2 @ 1 10i3 | = @Al 3

Question # 1 (# Revisit

‘What is your understanding of Liberal Education?

Record your response Maximum Recording fi 30 Mins

Center yourself within this frame

00:16/00:30
Mins.

Thinking Time

& Start Video Recording

Section3of 3 @

Question # 1

(# Revisit

Record your response

. Support & +91 82878 03040 =
> Tolal 00:05:10
il FLAME Online Admission Process 2021 €) . . Finish Test
4‘ UNIVERSITY Section 00:05:10

10i3 | = @Al 3

Maximum Recording time: 01:30 Mins

What is your understanding of Liberal Education? -
(i) The recording has started. Your response will be auto submitted when the recording stops.

\

00:14/01:30
Mins.

Center yourself within this frame

[®REC]

Recording Response

Stop Recording

. Support & +91 82878 03040 =

-
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27) Once you have recorded your responses, click on ‘Finish Test’.

> Total 00:03:00
FLAME Online Admission Process 20216 ® Finish Test

‘ UNIVERSITY Section 00:03:00

Question #3 Cft Revisit Record your response Maximum Recording time: 01:30 Mins

Share your story -
(> Your recorded response has been submitied.

&

Response Recorded

. Support & +91 82878 03040 = Prev Question

28) Please check the summary of your FLAME online admission process before final submission. Green

indicates attempted questions. Grey indicates questions not attempted/completed.

A Finish Test

Summary of your pts in this test is as shown below

83

Section Summary (3) Select section names to go back to that section.

FLAME Entrance Aptitu.. 81 19

Cancel Yes, Finish test

tests.mettl.com is sharing your screen. [EETESRCEUTTIN Hide
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29) Once you click on ‘Yes, Finish test’, the system will display the following message:

0 Finish Test

Finishing your test here. Please do not close this window.

30) Thank you message and request for feedback (not mandatory, but recommended).

B2 FLAME
' UNIVERSITY

FLAME Entrance Apiitude Test (FEAT) and Essay
e

- ’-&
Thank you for taking the test

1. The test instructions were Largely clear
2. Language of questions was Largely clear
3. Overall test experience was Good

Any other feedback / suggestions?

Facing technical difficulties taking this test? ¢, +91 82878 03040 ==
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GENERAL INSTRUCTIONS

A) In case you navigate away from the admission process window; the following message will appear on
your screen:

k@ Navigated Away
4

Natasha, you had navigated away from the test window. This will be reporied to
FLAME UNIVERSITY PUNE

Do not repeat this behaviour. Otherwise you may get disqualified.

Continue

tests.mettl.com is sharing your screen. [EESSCRTERIERN tide

B) Ifyou navigate way multiple times, you will be disqualified from appearing for the online admission
process.

@ Exceeded permissible limit for Navigating away
)

You have exceeded the permissible limit for navigating away from your test. Your
test has finished. You can close the window now.
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C) Never click on ‘Stop sharing’ during the FLAME online admission process.

>

3 M FLAME Entrance Aptitude Test (FEAT) and Essay € © Total02:20:38 Finish Test

,‘ UNIVERSITY
Section 4 0f 6 Verbal Abilit v & 1 = | 1ofdd | > @Al 40
Question #1 (Zr Revisit Choose the best option
The aq i ists of a that is either partly or entirely underlined and O were spend playing on the river banks, plucked fruits from their orchards and playing marbles
may or may net have a grammatical error. Below each sentence are four versions of the -
) was spent playing on the river banks, plucking fruits from their orchards and playing with marbles

underlined part of the sentence. Choose the option that y rep the i part - pent playing P 9 playing
of the given sentence. Mark the answer as ‘No Error' if there is no error in the underlined part. O was spent playing with the river banks, plucking fruits from their orchards and playing with marbles

7) spending playing on the river banks, plucking fruits from their orchards and playing with marbles
My grandfather talks of a childhood that was carefree and was spend playing on the river banks. - sp ¢ playing P q piaying

Rlucked fruits from their orchards and playing marbles; studying was just an ancillary activity.

O No Error

" {11 tosts metticom is shoring your screerll I ero Socton

p

Page 23 of 23



